Using the Network at AWC
a practical Guide for Users at Remote Locations

This document will help you understand how to improve your experience using the
computer systems at American Woodmark Corporation and includes helpful hints and
tricks for improving response time, using Outlook, and storing information on the
S:\, L:\, and U:\ shared drives on the AWC Network.
If you have any questions about the material covered in this document, please see
your Technical Support Specialist (TSS).
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Your Technical Support Specialist

Your primary contact for all computer and network issues is your TSS. Your TSS is
the intermediary between you and the MIS organization, and can provide support,
training, and answers to your computer and networking questions.

Talk to Your Local TSS about Issues Specific to
Your Site
American Woodmark has many sites and each site runs just a little differently. Your
TSS will know the issues that most impact your location and can provide you with
the information and training you’ll need to use your particular system to its best
advantage. Issues about distance and network congestion in particular should be
addressed with your local TSS.
If you have any questions about the material covered in this document, please see
your TSS.
For a listing of TSSs who support AWC manufacturing facilities, visit
http://woodmark/awc/corpmat/pages/TSS%20Organization.aspx.
For a listing of TSSs who support AWC sales and marketing locations, visit
http://woodmark/awc/CSIN/TSS/Lists/Contacts/AllItems.aspx.

Understanding Response Time

Slow response time, or latency, is a common frustration on large networks such as
ours at American Woodmark Corporation. Latency is a function of computational
capacity, which is a function of the number of files, the size of each file, and the
number of other jobs running on the host computer. Latency is also a function of
distance. Each of these issues are discussed below.

Response Time as a Function of File Size
Response time is related to the amount of data you send to the server and back. The
more data you send, the more time it takes to send and receive confirmation.
Any steps you can take to compact, compress, and streamline data will have big
pay-offs in response time because the system will be processing fewer bits of data.
For suggestions about how to reduce the size of your files, see the following
sections:
 Compacting Your Outlook Files on page 6,
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Compressing Files on page 17, and
About Pictures and Graphics Files on page 17.

Response Time as a Function of Network and
Server Congestion
Response time is related to the number of other jobs running on the network and the
number of other jobs running on the host computer. The busier the system, the
more time it takes to get your job there and back.
Appearances can be deceiving. Since AWC runs many jobs automatically during nonbusiness hours, you don’t necessarily have to see users logged on or sitting at their
desks for the system to be busy.
Any steps you can take to delete and archive files on shared resources (like the S:\
drive) will have big pay-offs in response time because the automated processes will
run faster with fewer files.

Response Time as a Function of Distance
Response time is related to the distance that data has to travel from the time your
computer connects with the server and back to your computer. The greater the
distance, the more time it takes to send and receive data. AWC systems are located
in widely scattered places, such Kingman, AZ and Sacramento, CA. Geographic
distance has a noticeable impact on system response time at many locations
throughout AWC.
Users should be aware that distance can be an issue, adjust their expectations
accordingly, and plan ahead when they travel from site to site.
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Figure 1. American Woodmark Location Map
AWC Examples:
 Sacramento, CA to Winchester, VA—2,678 miles, about 1 day + 15 hours by car
 Kingman, AZ to Winchester, VA—2,286 miles, about 1 day + 9 hours by car
 Berryville, VA to Winchester, VA—18 miles, about 33 minutes by car

Using Microsoft Outlook

Regular housekeeping ensures quick synchronization between the server and the
client (your computer). Clean out your Inbox, Sent Items, and Deleted Items on
a regular basis, and use Personal Folders.

Outlook Personal Folders vs. Mailbox Folders
Mailbox Folders, such as your Inbox, Sent Items, and Deleted Items, store
information both on the Local computer and the Server.
Personal Folders store information on the Local computer only. To access
messages more quickly, avoid the server by using Personal Folders, but be aware
that Personal Folders have a file size limit:
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The Personal Folder *.pst file should not exceed 2 GB, roughly
equivalent to enough data to fill 3 CD-Rs.



The Mailbox Folder file cannot exceed 500 MB, roughly equivalent to ¾
of 1 CD-R.

The Mailbox Folder file will trigger warning messages when the size
reaches 300 MB. After 500 MB, nothing will be allowed in or out of the
Mailbox Folder.
Do not locate the working copy of these *.pst files on the network. These files do
not belong on the U:\ drive as working files. You may use the network to back up
these files on the U:\ drive.

Attachments
Outlook Attachment Size Limits

American Woodmark’s Outlook system has limited the size of attachments to 25 MB,
roughly equivalent to 12 large screen captures. This is a Global setting for all users.

Alternatives to Outlook Attachments

Rather than emailing large attachments, use SharePoint or send emails with
hyperlinks or pathnames to the file when you need to share spreadsheets, reports,
and other large files. This is especially important if you are sending information to
multiple users or if you are sending out information on a routine basis.

AWC Business Use Only
Use the American Woodmark Outlook Server for business purposes only; do not send
or receive personal email.
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Regular Housekeeping for Outlook Users
Be sure to perform regular housekeeping as described in the processes that follow.

Compacting Your Outlook Files

Outlook online help calls this “Reduce the size of a data file.”

A data file is a Personal Folders file (*.pst). If you delete items from a data file,
the size of the file will not change unless you compact the file. Compacting the file
might take several minutes.
1. On the Outlook File menu, click Data File Management.
2. Click the data file that you want to compact, and then click Settings.
3. Click Compact Now. The Compacting process begins and may take several
minutes to complete.
Note: When you compact a *.pst file, you do not have to exit Microsoft Outlook.

Archiving Outlook Files
Setting Up Auto-Archive

Set up the Outlook Auto-Archive feature to perform regular housekeeping.
1. On the Tools menu, click Mailbox Cleanup.
The Mailbox Cleanup dialog appears.
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2. Click AutoArchive. The Auto-Archive feature is turned on.

Manually Archiving Folders to Be Backed Up on U:\

Complete the following steps to set the location of your Archive file so that it will be
backed up when you run the backup script:
1. On the Go menu, click Folder List.
2. Select the folder that you want to archive. You can select your mailbox and all

3.
4.
5.
6.

of your mailbox subfolders by selecting
Mailbox. You can select
your personal folders and all of your personal subfolders by selecting
Personal Folders.
On the File menu, click Archive.
Choose Archive this folder and all the subfolders.
Choose an archive date, or accept the default.
Click Browse … .
The Open Personal Folders dialog appears.
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7. Browse to the path within your My Documents or Documents folder, and
then open the Outlook folder.
8. Choose an existing archive file or create a new file by typing a new name. If
you choose an existing file, your newly archived items will add to the existing
archive data, not replace it.
9. Click OK.
The items in the folder are moved out of the folder and into the .pst file that
you specified. The Archive appears in your Folder List.
10. To view the archived items again, open
your Folder List.

the Archive folder in

11. Before you run the backup script, close Outlook.
12. Run the backup script by clicking the Backup Files to Server shortcut on
your desktop.
For more information on running the backup script, see File Backup and
Retrieval—the U:\ Drive on page 15.

Manually Archiving Folders to CD or DVD

MIS Networks & Technologies suggests that users store archived Outlook information
on a CD or DVD media. Follow the steps given above for backing up to the U:\ drive,
and select the CD or DVD drive on your computer in step 7.
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Viewing Outlook Folder Sizes
Use this process to see the sizes in KB of each folder in your Mailbox or Personal
Folders.
1. Select the folder, subfolder or branch along the folder tree for which you want
to view folder sizes.
2. Right-click the folder and choose Properties.
3. Click Folder Size.
—OR—
1. Open the Folder List by clicking
is displayed.

, the Folder List icon. The Folder List

2. Select the folder, subfolder or branch along the folder tree for which you want
to view folder sizes.
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3. In the Folder List, scroll all the way down to the bottom until you see the
Folder Sizes shortcut.

4. Click Folder Sizes. The Folder Size dialog opens.
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Use this process to see the sizes in KB of each folder in your Mailbox.
1. Select the folder, subfolder or branch along the folder tree for which you want
to view folder sizes.
2. In the Tools menu, click Mailbox Cleanup. The Mailbox Cleanup dialog
opens.

3. Click View Mailbox Size. The Folder Size dialog opens.
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Using Blind Carbon Copy
Using the Blind Carbon Copy function (Bcc) in Outlook has a few advantages.
Blind copying refers to the practice of sending a message to multiple recipients in
such a way that what they receive does not contain the complete list of recipients.
This practice is traditionally used to protect some recipients from spam and other
unwanted email traffic.
Consider using the Bcc function for FYI recipients who may not need any follow-on
comments from the team. Then team members can choose Reply All and avoid all
but the key people on the team who need to receive follow up. Using the Bcc
function will reduce email congestion by ensuring that FYI recipients receive the
initial email but are not included in follow-on responses.
To display the Bcc field in an email, from the View menu, click Bcc Field.

Using Webmail
From within the Company

Access your Outlook Inbox, Contacts, Calendar, and Public Folders from any
computer with Intranet access at http://AWCiNet/webmail

Figure 2. Premium Option webmail
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From outside the Company

Access your Outlook Inbox, Contacts, Calendar, and Public Folders from any
computer with Internet access at www.woodmark.com/mail.

Choose Premium on a high speed connection. The premium client provides all
Outlook Web Access features. See Figure 2 on page 12 for an example of Premium
webmail.
Choose Basic on a slower connection. The basic client provides fewer features than
the premium client but offers faster performance. Use the basic client if you're on a
slow connection.

Figure 3. Basic Option webmail
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Using Network Drives

Network drives at AWC provide a convenient means of sharing and backing up data.

File Sharing
When sharing files for editing, communicate with other potential users to make sure
that only one user has the file checked out for editing at a time.
MIS Networks & Technologies suggests that you edit files by copying them to your
local hard drive, and then make any changes on your local hard drive. Upload the
final edited version to the shared file location as the last step.
A file sharing utility such as MicroSoft Visual SourceSafe is recommended. For
more information about obtaining and using this utility, contact your TSS.

File Sharing—the S:\ Drive
The S:\ drive is available to all AWC users across the network.
Use the S:\ drive to share files with users at other locations.
S:\Public is PUBLIC. S:\Public CANNOT be secured for restricted access by individuals
or user groups.

Tips for Keeping the S:\ Drive as Clean as Possible





Compress data files using the steps outlined in How to Use Windows File
Compression on page 17.
Clean out (delete or move to another location) any files older than 30 days.
Don’t use the S:\ as an archive drive. Use the S:\ drive to share files.
Copy files to your PC to make changes and updates. Do not work on files
across the network.

Remember, you are responsible for the cleanup of your files and folders.
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Local File Sharing—the L:\ Drive
The L:\ drive is available to users at your location only. It is not accessible across the
network.
Use the L:\ drive to share files with users at your location.
The L:\ drive can be secured for restricted access by different individuals and user
groups.
Organize the L:\ drive as you do your C:\ drive. Create folders and subfolders with
meaningful names for easier retrieval. Avoid saving files to the L:\ root directory.

File Backup and Retrieval—the U:\ Drive
The U:\ drive is also local to your location, and is available to users
at your location only.
Use the U:\ drive to store backup data from your PC. Run the backup
program, BackupScript.bat, by clicking the Backup Files to
Server shortcut on your desktop.
Note: Close all programs before running the backup utility.

Tips for Using the U:\ Drive






All working data files should be located in your \My Documents folder.
Do not work from the U:\ drive. This drive is only for backup and retrieval.
The U:\ drive is backed up to tape on a nightly basis.
Please do not store your personal pictures or music files on the U:\ drive.
Contact your TSS about where pictures and music can be stored on your
hard drive so they will not be backed up to the U:\ drive.
Remember that deleting files from your local PC does NOT delete it from
your U:\ drive folder. Clean out the U:\ drive periodically.

Mapping to a Network Directory
You must already be connected to the network in order to add a network printer. To
map to a directory on your network, perform the following steps:
1. Double-click the My Network Places desktop icon.

The My Network Places Microsoft Explorer window appears.
2. From the Tools menu, click Map Network Drive. The Map Network Drive
dialog appears.
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3. From the Drive pull-down list, select a drive letter.
4. In Folder, type the path of the network drive to which you want to connect,
in quotes, for example “\\AWCServer3\Clients”,
or click Browse… to navigate along your network path to the folder.
5. To reconnect to the mapped drive every time you log on, select the
Reconnect at logon check box.
6. Click Finish. The drive is now mapped on the computer.
Notes:
Availability of mapped drives—Mapped drives are available only
when the host computer is available. A host computer is a Windows
computer that runs a server program or service used by network or
remote clients.
Assigning drives to different letters—You can assign a computer or
shared folder to a different drive letter by disconnecting from the drive
and then reassigning it to a new drive letter. For more information, see
the Explorer window Online Help.

Revision 01/27/09

page 16 of 24

Compressing Files

MIS Networks & Technologies recommends using the Windows File Compression
utility to compress files.

How to Use Windows File Compression

To use the Windows File Compression utility, perform the following steps:
1. Navigate to the file or files you want compressed, and then select the files.
 Press Ctrl to multiselect files,
 Press Shift to select a range of files, or
 Press Ctrl + A to Select All files within a folder.
2. Right-click the selected files, and then on the Send To menu, click Compressed
(zipped) Folder.

About Pictures and Graphics Files

Pictures, scans and other graphics files can be some of the largest files on your
system. Additionally, these files tend to be the ones we are most likely to share and
circulate. Good picture file etiquette can be of great benefit, not only to you, but to
everyone on your team and on your network.
As much as possible, keep picture and graphics file sizes to a minimum.

JPEGs vs. GIFs

Whenever possible, save graphics as GIFs (*.gif). Typically GIF files are one third to
one half the size of a JPEG (*.jpg) for the same size and resolution. Bitmaps
(*.bmp), on the other hand, can be as much as 10 times the size of a JPEG.
 GIFs are typically better for images with only a few distinct colors, such as
line drawings, icons, and logos.
 JPEGs are better for photographs and graphics with subtle shading.

Scanning DPI

200-300 dots per inch (DPI) is sufficient for on-screen readability and for most
hardcopy applications.
It is important to note that a small change in scanning DPI can have an exponential
impact on the size of the file. For example, doubling the DPI will increase the file size
by a factor of four (2 x 2 = 4) and tripling the DPI will increase the file size by a
factor of nine (3 x 3 = 9) due to the 2 dimensional nature of graphics.

Scanning for Signatures

When you are scanning authorizations and signatures (printing, signing, then
rescanning and forwarding to another user who will print, sign and scan), you may
find that 450 DPI is a better scanner setting. Higher resolutions will keep the images
from degrading from scan to scan. Repeated scanning and printing can lead to fuzzy
looking scans after the third or fourth generation and will require a higher DPI.
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What’s a Pixel?

A pixel is a picture element. Most folks think of it as one of the square shaped dots
that make up a picture. Put enough pixels together and you get a picture. The more
pixels you have, the sharper the image. However, each pixel takes up file space.
Pictures with fewer pixels take up less space than pictures with lots of pixels. Try to
strike a balance between the clarity of the image and the storage space required to
support it.

Resizing Picture Files

Use a graphics package such as SnagIt Editor to change the pixel size of picture
files. Reduce the size to something that approximates the size at which the picture
will be viewed on-screen or read as hardcopy.
To resize a picture in SnagIt Editor, perform the following steps:
1. From the Image menu, click Scale, and then click Resize Image.

2. Choose a pixel size that approximates the size at which the picture will be viewed
or read.
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Examples:
Pixel Size
100 pixels x 100 pixels

Image

Dimensions
1.04” x 1.04”

150 x 150

1.56” x 1.56”

200 x 200

2.08” x 2.08”

Resizing for On-Screen Viewing

Screen resolutions vary from system to system, but a good rule of thumb is
approximately 85 pixels per inch on a 21” diagonal monitor set at 1280 by 1024 pixel
screen resolution. A graphic that measures 340 x 510 pixels will display as 4” x 6”.

Resizing for Hardcopy Using Microsoft Word

Graphics resolution using Microsoft Word is approximately 96 pixels per inch. A
graphic that measures 384 x 576 pixels will print as 4” x 6”.

Using Microsoft Access

Network latency (distance) has a greater impact on poorly constructed queries. The
following is a list of tips to improve the performance of Access Queries.




Run Access queries from a local copy. Do not open Access databases
from remote servers. Instead, copy the database or use links.
Limit queries by using an Access where clause or constraints.
Do not join local tables with remote tables. Join local tables to local
queries of remote tables.
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Do not join tables from different data sources. Join queries of tables from
different data sources.
Use pass-through queries.

For more tips about improving the performance of your Access queries, see your
TSS.

About Printers

When your computer is connected to a printer, it will periodically send a signal and
wait for a response to return back from the connected printer. This is the process
that lets you know whether the printer is online, out of paper, out of toner, etc. This
call and response adds to the network congestion on the system.
Help to relieve network congestion by disconnecting from remote printers you no
longer need and cancelling unwanted print jobs in the printer queue.

Disconnect Printers when You Leave a Remote Site

To disconnect from a printer, perform the following steps:
1. From the Windows Start menu, select Start.
2. Click Settings, then click Printers and Faxes. The Printers and Faxes
window opens.
3. Right-click the printer from which you want to disconnect, and then select
Delete. The Printers confirmation dialog opens.
4. Click Yes to delete and disconnect, otherwise click No to start over. The
printer disappears from the Printers and Faxes window.

Cancel Unwanted Jobs in the Printer Queue

To cancel a job in the printer queue, perform the following steps:
1. From the Windows Start menu, select Start.
2. Click Settings, then click Printers and Faxes. The Printers and Faxes
window opens.
3. Double click the printer. The specific printer window opens.
4. Select the document you want to cancel.
5. From the menu at the top, select Document, and then click Cancel.
The Printers confirmation dialog opens.
6. Click Yes to cancel the job, otherwise click No to start over.
The job disappears from the window.

Map a Network Printer In Windows XP.

You must already be connected to the network in order to add a network printer. To
add a network printer, perform the following steps:
1. Click the Start menu, click Settings, and then click Printers and Faxes.
2. Click Add a Printer. The Printers and Faxes window opens.
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3. Click Add a Printer in the Printer Tasks pane. The Add a Printer Wizard
opens.

4. Click Next to continue.

5. Select the A network printer option, and then click Next.

Revision 01/27/09

page 21 of 24

6. Choose Yes or No depending on whether or not this will be your Default
printer.

7. Click Finish. It is not necessary to restart your computer.

You are now connected to the network printer.
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Common Sense Advice from MIS
Good Housekeeping

Don’t hang on to things you don’t need. Don’t keep old files you are not using and
will never use again. Instead, move historical and obsolete data to a CD or DVD.
Remember to delete the backup copy from the U:\, L:\, and/or S:\ drives.
Remove unwanted programs using the Add or Remove Programs
utility in you PC’s Control Panel. Only use AWC Licensed and
Approved Software.
You are responsible for your data. Work smart to use data and
systems to their best advantage.

Back up BEFORE You Travel

Plan ahead before you travel.
 When making plans for AWC business travel, be sure to back up your data
files prior to leaving your location.
 If you are taking a shared laptop, be sure to set up and load data files to
the laptop prior to leaving your location. This is especially important for
email users.
 If you wait until you are at the remote site, access to shared systems such
as email will be much slower. Consider getting your mail using webmail,
as instructed in Using Webmail on page 12.

Treasure Your Passwords

Make a note of new passwords and keep them in a secured location.

Safeguard Computer Settings

MIS Networks & Technologies recommends leaving the computer settings
unchanged. Many users experience problems that take a lot of time to resolve simply
because they have changed the computer settings to be different from the way they
were set up by MIS PC Support.
As you move from PC to PC, either by using another user’s PC or by using one
designated for group use, you will save time and energy if you leave these settings
unchanged, and you’ll be able to adapt to a new computer when it’s time to upgrade.

Double Check that Power Is On and Everything Is
Connected

We know it seems silly, but some users call for help only to find that the system
power is off or that a cable is not plugged in properly.
Don’t let this happen to you. When your system is acting up, it’s normal to feel
frustrated and upset. Take a minute to collect your thoughts and check for power
and connections. If you call for help with a system that is simply unplugged, you will
feel embarrassment on top of the frustration you felt a minute before. You’ll be glad
that you took a minute to check the plugs prior to calling in a problem.
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Shut Down the Wireless Network Connection when LAN
Connected

There are several ways to disable the wireless network connection. Not all of these
operations are available for all laptop systems. Choose a process that is compatible
with your configuration from the list below:
 Press Function + F2.
—OR—


Slide the switch on the side of the laptop.
—OR—



Right click the

tray icon and select

Disable Radio.

Log off and Power down at Night

Power down the computer and the monitor when you leave for the day.

Get to Know Your TSS
Your TSS serves as the regional contact for system and process issues, acts as your
location’s liaison to MIS, offers system enhancement suggestions, addresses issues,
and facilitates forward thinking. Your primary contact for all computer and network
issues is your TSS, your Technical Support Specialist. Your TSS can provide support,
training and answers to your computer and networking questions.
If you have any questions about the material covered in this document or about any
other systems issue, contact your TSS.
For a listing of TSSs who support AWC manufacturing facilities, visit
http://woodmark/awc/corpmat/pages/TSS%20Organization.aspx.
For a listing of TSSs who support AWC sales and marketing locations, visit
http://woodmark/awc/CSIN/TSS/Lists/Contacts/AllItems.aspx.
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